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1. Penting

Buku petunjuk elektronik ini ditujukan untuk
siapapun yang menggunakan monitor Philips.
Luangkan waktu untuk membaca panduan
pengguna sebelum menggunakan monitor.
Panduan tersebut berisi informasi dan catatan
penting tentang cara mengoperasikan monitor.

Jaminan Philips berlaku pada produk yang
penggunaannya ditangani dengan baik sesuai
dengan petunjuk pengoperasian dan atas
presentasi faktur asli atau resi yang menunjukkan
tanggal pembelian, nama dealer, nomor model,
dan nomor produksi produk.

1.1 Tindakan pencegahan dan
pemeliharaan

) Peringatan

Penggunaan kontrol, penyesuaian, maupun
prosedur selain yang dijelaskan dalam
dokumentasi ini dapat mengakibatkan sengatan
listrik, bahaya listrik, dan/atau bahaya mekanis.

Baca dan ikuti petunjuk ini saat menyambungkan
dan menggunakan monitor komputer.

Pengoperasian

* Jauhkan monitor dari sinar matahari
langsung, kompor, maupun sumber panas
lainnya.

* Pindahkan objek apapun yang dapat jatuh
ke lubang ventilasi atau mungkin mencegah
pendinginan elektronik yang benar pada
monitor.

* Jangan halangi lubang ventilasi pada kabinet.

» Saat menetapkan posisi monitor, pastikan
konektor daya dan stopkontak mudah
dijangkau.

* Jika mematikan monitor dengan melepaskan
kabel daya atau kabel daya DC, tunggu
selama 6 detik sebelum memasang
kabel daya atau kabel daya DC untuk
pengoperasian biasa.

* Selalu gunakan kabel daya yang disetujui dan
disediakan oleh Philips. Jika kabel daya tidak

ada, hubungi pusat layanan setempat. (Lihat
Pusat Informasi Layanan Pelanggan)

* Jaga agar monitor terhindar dari getaran
kencang atau kondisi berbahaya lainnya
selama pengoperasian berlangsung.

* Jaga agar monitor tidak terjatuh atau
terbentur selama pengoperasian atau
pengiriman.

Pemeliharaan

*  Untuk melindungi monitor dari
kemungkinan kerusakan, jangan letakkan
benda berat di atas panel LCD. Saat
memindahkan monitor, pegang bingkai
untuk mengangkat, jangan angkat monitor
dengan meletakkan tangan atau jari pada
panel LCD.

* Lepas sambungan monitor jika Anda tidak
akan menggunakannya dalam waktu lama.

* Lepas sambungan monitor jika Anda
akan membersihkannya dengan kain yang
lembab. Layar dapat dibersihkan dengan
kain yang kering saat dimatikan. Namun,
Jangan pernah gunakan larutan organik,
seperti alkohol atau cairan beramonia untuk
membersihkan monitor.

*  Untuk menghindari risiko sengatan listrik
atau kerusakan permanen, jangan biarkan
monitor terkena debu, hujan, atau air,
maupun berada dalam lingkungan dengan
kelembaban berlebihan.

* Jika monitor basah, segera seka dengan kain
kering.

 Jika benda asing atau air masuk ke dalam
monitor, segera matikan daya dan lepas
kabel daya. Setelah itu, keluarkan benda
asing atau air tersebut, lalu bawa ke pusat
pemeliharaan.

* Jangan simpan atau gunakan monitor di
lokasi yang bersuhu panas, terkena sinar
matahari langsung, atau bersuhu sangat
dingin.

*  Untuk memelihara performa terbaik
monitor dan memperpanjang masa
pakainya, gunakan monitor di lokasi dalam
kisaran suhu dan kelembaban berikut.

. Suhu: 0-40°C 32-95°F

. Kelembaban: 20-80% RH



*  PENTING: Aktifkan selalu program
screensaver bergerak bila Anda
meninggalkan monitor. Aktifkan selalu
aplikasi refresh layar berkala jika monitor
akan menampilkan konten statis yang tidak
berubah. Tampilan gambar diam atau
gambar statis yang tidak berubah dalam
waktu lama dapat menimbulkan “efek
terbakar”, disebut juga “jejak gambar’ atau
“bayangan”, di layar.

"Efek terbakar", "jejak gambar”, atau
"bayangan" adalah fenomena umum dalam
teknologi panel LCD. Dalam sebagian besar
kasus, “efek terbakar”, “jejak gambar”,

atau “bayangan” akan menghilang secara
bertahap dalam waktu tertentu setelah daya
dimatikan.

) Peringatan

Gejala “efek terbakar”, “jejak gambar”, atau
“bayangan” yang fatal tidak akan hilang dan tidak
dapat diperbaiki. Kerusakan yang disebutkan di
atas tidak tercakup dalam jaminan.

Layanan

* Penutup casing hanya dapat dibuka oleh
teknisi ahli.

* Jika harus memperbaiki atau mengintegrasi
dokumen, hubungi pusat layanan setempat.
(lihat bab "Pusat Informasi Konsumen")

*  Untuk informasi pengiriman, lihat "Spesifikasi
Teknis".

* Jangan tinggalkan monitor di dalam mobil/
bagasi di bawah sinar matahari langsung.

© Catatan

Hubungi teknisi servis jika monitor tidak
beroperasi secara normal atau Anda tidak yakin
dengan prosedur yang harus dilakukan bila
petunjuk pengoperasian yang diberikan telah
diikuti.

1.2 Keterangan Penulisan

Subbab berikut menjelaskan konvensi penulisan
yang digunakan dalam dokumen ini.

Catatan, Perhatian, dan Peringatan

Dalam buku petunjuk ini, beberapa teks mungkin
disertai ikon dan dicetak dengan huruf tebal atau
miring. Teks tersebut berisi catatan, perhatian,
atau peringatan yang digunakan sebagai berikut:

& Catatan

lkon ini menunjukkan informasi penting dan
tips yang akan membantu Anda memanfaatkan
sistem komputer dengan lebih baik.

@ Perhatian

lkon ini menunjukkan informasi yang
memberitahukan Anda tentang cara menghindari
kemungkinan kerusakan perangkat keras atau
hilangnya data.

7 Peringatan

lkon ini menunjukkan kemungkinan cedera
dan memberitahukan Anda tentang cara
menghindarinya.

Beberapa peringatan mungkin ditulis dalam
format lain dan mungkin tidak disertai dengan
ikon. Dalam hal ini, penulisan peringatan tertentu
diwajibkan oleh peraturan pemerintah terkait.



1.3 Pembuangan produk dan materi
kemasan

Waste Electrical and Electronic Equipment-
WEEE

This marking on the product or on its
packaging illustrates that, under European
Directive 2002/96/EC governing used electrical
and electronic appliances, this product may
not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.

Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations on
how to dispose of your old monitor and packing
from your sales representative.

Recycling Information for Customers

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling program
please visit www.philips.com/about/sustainability/

recycling.




2 Memasang monitor 2 Memasang dudukan dasar
) 1. Letakkan monitor menghadap ke bawah

pada permukaan yang halus dan lembut
agar layar tidak tergores atau rusak.

2.1 Pemasangan

KN Isi kemasan

%i‘cfart

PHILIPS

S e — 2. Pegang penyangga dudukan dengan kedua
H B tangan, lalu masukkan penyangga dudukan
e dengan kuat ke dalam batang dudukan.

(1) Pasang dudukan secara hati-hati
ke batang dudukan hingga kaitnya
mengunci dudukan.

(2) Gunakan jari untuk mengencangkan
sekrup yang terdapat di bagian dasar
dudukan, lalu amankan dudukan ke

Kabel audio batangnya dengan kuat.

(opsional)

VGA (opsional) DVI (opsional)




H Menyambungkan ke PC

Model 227E3L:

PHILIPS

(]
®

(1] Input daya AC
Input VGA
O input DVID
Kunci antipencurian Kensington

Model 227E3LH:

PHILIPS

0006 0

(@]

(1) Input daya AC
Input VGA
Input DVI-D
O out HOMI
Input Audio
Output audio
Kunci antipencurian Kensington

Model 227E3LPH:

PHILIPS

(1) Input daya AC
(2 Input VGA
© input DVID
Input HDMI
© output audio HOMI
Kunci antipencurian Kensington

Menyambung ke PC

1. Sambungkan kabel daya dengan kuat ke
bagian belakang monitor.

Matikan komputer dan lepas kabel daya.

3. Sambungkan kabel sinyal monitor ke
konektor video di bagian belakang
komputer.

4. Sambungkan kabel daya komputer dan
monitor ke stopkontak di sekitar.

5. Hidupkan komputer dan monitor. Jika
monitor menampilkan gambar, berarti
pemasangan telah selesai.



2.2 Mengoperasikan monitor

(7 3

PHILIPS

T i

1 Keterangan produk bagian depan
Model 227E3L:

Model 227E3LH:

54

/v /A 1/ < /0K )

| | [\ |
7 06 O e o (1

Menghidupkan dan mematikan
daya monitor.

(5]

/v ©/A 10/< /0K 0)
| | [\ | |
7] (6] ©®© 6 o (1]

Menghidupkan dan mematikan
|

o O daya monitor.

O =) /0K|Mengakses menu OSD.
Kembali ke tingkat OSD

o < sebelumnya.

Menyesuaikan volume suara

o 'd speaker.

© | A ¥V Menyesuaikan menu OSD.

O © Mengubah sumber input sinyal.
Smartlmage Lite. Ada tiga mode
yang dapat dipilih: Standard

e iy (Standar), Internet, dan Game
(Permainan).

& /0K |Mengakses menu OSD.

Kembali ke tingkat OSD
sebelumnya.

o |Beralih ke tampilan 4:3.

A V¥V |[Menyesuaikan menu OSD.

@060 0 O

©) |Mengubah sumber input sinyal.

Model 227E3LPH:

& yang dapat dipilih: Standard
(Standar), Internet, dan Game
(Permainan).

Smartlmage Lite. Ada tiga mode

(5]

/v /A SENSOR/ < /0K Q)
| | [\ | |
7] (6] ©®© 6 o (1]

Menghidupkan dan mematikan
|

o O daya monitor.

O = /0K|Mengakses menu OSD.
Kembali ke tingkat OSD

o < sebelumnya.

Menetapkan tingkat sensor untuk

O | SENSOR kontrol otomatis cahaya latar.

© | A ¥V Menyesuaikan menu OSD.

O ©® Mengubah sumber input sinyal.
Smartlmage Lite. Ada tiga mode
yang dapat dipilih: Standard

o @ (Standar), Internet, dan Game
(Permainan).




2 Keterangan On Screen Display

Apakah yang dimaksud dengan OSD (On-
Screen Display)?

OSD (On-Screen Display) adalah fitur yang
terdapat pada semua monitor LCD Philips.
Pengguna akhir dapat menggunakannya untuk
menyesuaikan performa layar atau memilih
fungsi monitor secara langsung melalui jendela
petunjuk di layar. Antarmuka tampilan di layar
yang mudah digunakan muncul seperti di bawah
ini:

Model 227E3L:

= VGA .
&= Input —_

Model 227E3LPH:

)] Power Sensor

J e
|ﬂ;

Petunjuk dasar dan mudah pada tombol
kontrol

Pada OSD yang ditampilkan di atas, Anda
dapat menekan tombol ¥ A pada bezel depan
monitor untuk menggerakkan kursor, lalu tekan
tombol OK untuk mengonfirmasikan pilihan
atau perubahan.

Menu OSD

Berikut adalah tampilan keseluruhan dari
struktur On-Screen Display. Anda dapat
menggunakannya sebagai referensi bila ingin
melakukan penyesuaian lainnya nanti.

Main menu Sub menu
Power Sensor [ On — 0~4
Off
(available for selective models)

— VGA
Input

— DVI (available for selective models)

L— HDMI (available for selective models)

— Picture Format —— Wide Screen, 4:3
Picture

— Brightness — 0~100

— Contrast — 0~100

Off, Fast, Faster, Fastest

[— SmartResponse " (available for selective models)

L— SmartContrast —— On, Off

— Volume —— 0~100 (available for selective models)
Audio

— Stand Alone — On, Off

— Mute — On, Off

— Color Temperature — 6500K, 9300K
Color

— sRGB

— User Define Red: 0~100

E Green: 0~100
Blue: 0~100

Language — English, Espariol, Frangais, Deutsch, Italiano,

Portugués, Pycckui, fEIRARISZ, Turkge

OSD Settings — Horizontal — 0~100
— Vertical — 0~100
— Transparency — Off,1,2,3,4
— OSD Time out — 5,10, 20, 30, 60
Setup — Auto
— Power LED — 0,1,2,3,4
— Over Scan —— On, Off (available for selective models)
— H. Position — 0~100
— V. Position — 0~100
— Phase — 0~100
— Clock — 0~100
[ Resolution Notification — On, Off
— Reset — Yes, No
L— Information



El Pemberitahuan resolusi

Monitor ini dirancang untuk memberikan
performa optimal pada resolusi aslinya, yakni
1920 x 1080 pada 60 Hz. Bila monitor
dihidupkan pada resolusi yang berbeda, layar
akan menampilkan peringatan: Gunakan 1920 X
1080 pada 60 Hz untuk hasil terbaik.

Tampilan peringatan resolusi asli dapat
dinonaktifkan dari Setup (Konfigurasi) dalam
menu OSD (Tampilan di Layar).

4] Fungsi Fisik

Kemiringan

2.3 Melepas Dudukan dan Dudukan
Dasar

1 Melepas Dudukan Dasar

Sebelum mulai membongkar penyangga
monitor, ikuti petunjuk di bawah ini agar
terhindar dan kemungkinan kerusakan atau
cedera.

1. Letakkan monitor menghadap ke bawah
pada permukaan yang halus agar layar tidak
tergores atau rusak.

2. Lepas penyangga dudukan dari batang
dudukan dengan cara:

(1) Menggunakan jari untuk melonggarkan
sekrup yang terdapat di bagian dasar
dudukan.

(2) Menggeser ke atas dan bawah secara
perlahan untuk melepas kait yang
mengunci dudukan, lalu menarik
dudukan dari batang dudukan.




2 Melepas dudukan

1. Anda dapat menggunakan obeng minus
pada kedua lubang pelepas di penutup
engsel, lalu membuka penutup engsel secara
hati-hati hingga terlepas.

2. Lepas 4 sekrup, lalu lepas dudukan dari
monitor.




3. Pengoptimalan Gambar

3.1 Smartlmage Lite

E} Apakah yang dimaksud dengan
SmartContrast?

Smartimage Lite memberikan preset yang
mengoptimalkan layar untuk berbagai jenis
konten dengan menyesuaikan kecerahan,
kontras, warmna, serta ketajaman secara real
time dan dinamis. Meskipun Anda bekerja
dengan aplikasi teks, menampilkan gambar,
atau menonton video, Philips Smartlmage
Lite memberikan performa monitor yang
dioptimalkan.

FJ Mengapa saya memerlukannya?

Anda memerlukan monitor yang memberikan
tampilan semua jenis konten favorit yang
dioptimalkan. Perangkat lunak Smartimage Lite
akan menyesuaikan kecerahan, kontras, wama,
serta ketajaman secara real time dan dinamis
untuk menyempurnakan pengalaman tampilan
monitor Anda.

E} Bagaimana prosedurnya!’

Smartimage Lite merupakan teknologi eksklusif
dan canggih dari Philips yang menganalisis konten
yang ditampilkan di layar. Berdasarkan skenario
yang dipilih, Smartimage Lite menyempurnakan
kontras, saturasi warna, dan ketajaman gambar
secara dinamis untuk menyempurnakan konten
yang sedang ditampilkan. Semua dapat dilakukan
secara real time dengan menekan satu tombol.

B} Bagaimana cara mengaktifkan Smartlmage
Lite?

(7 —)

@

\ PHILIPS ),

L

1. Tekan BD untuk mengaktifkan Smartlmage
Lite di layar;
2. Tekan terus B untuk beralih di antara

10

Standard (Standar), Internet, dan Game
(Permainan).

3. Tampilan Smartlmage Lite akan tetap
muncul di layar selama 5 detik atau
Anda juga dapat menekan “OK" untuk
mengkonfirmasi.

4. Bila Smartlmage Lite diaktifkan, skema
sRGB akan dinonaktifkan secara otomatis.
Untuk menggunakan sRGB, Anda harus
menonaktifkan Smartlmage Lite dengan
tombol BD di bezel depan monitor.

Selain menggunakan tombol Bf) untuk menggulir
ke bawah, Anda juga dapat menekan tombol

v A untuk memilih, lalu menekan “OK" untuk
mengkonfirmasi pilihan dan menutup OSD
Smartlmage Lite.

Ada tiga mode yang dapat dipilih: Standard
(Standar), Internet, dan Game (Permainan).

@ SmartImage U

Standard

Internet

 Standard (Standar): Menyempurnakan
teks dan mengurangi kecerahan untuk
meningkatkan kemampuan baca serta
mengurangi kelelahan pada mata. Mode
ini secara nyata akan menyempurnakan
kemampuan baca dan produktivitas saat
Anda bekerja dengan spreadsheet, file PDF,
artikel yang dipindal, atau aplikasi kantor
umum lainnya.

* Internet: Profil ini menggabungkan saturasi
warna, kontras dinamis, dan penyempurnaan
ketajaman untuk menampilkan foto dan
gambar lain dengan kejernihan yang luar
biasa dalam warna yang menarik. Semua
dilakukan tanpa memerlukan alat bantu lain
dan tanpa adanya warna yang pudar.

* Game (Permainan): Mengaktifkan sirkuit
drive untuk waktu respons terbaik,
menghilangkan tepi bergerigi untuk
objek yang bergerak cepat di layar, serta
meningkatkan rasio kontras untuk skema
terang dan gelap. Profil ini memberikan
pengalaman terbaik bagi penggemar
permainan dalam menjalankan permainan.




3.2 SmartContrast

El Apakah yang dimaksud dengan
SmartContrast?
Teknologi unik yang secara dinamis menganalisis
konten yang ditampilkan serta secara otomatis
mengoptimalkan rasio kontras monitor LCD
untuk kejernihan visual dan kenyamanan
tampilan maksimal dengan menambah cahaya
lampu latar agar gambar lebih jernih, tajam,
dan terang, atau mengurangi cahaya lampu
latar untuk tampilan gambar yang jelas di latar
belakang gelap.

F3 Mengapa saya memerlukannya?

Anda menginginkan kejernihan visual dan
kenyamanan tampilan terbaik untuk setiap
jenis konten. SmartContrast secara dinamis
mengontrol kontras dan menyesuaikan cahaya
lampu latar agar gambar dalam permainan
serta video lebih jernih, tajam, dan terang, atau
menampilkan teks yang jelas dan mudah dibaca
untuk pekerjaan kantor. Dengan mengurangi
pemakaian daya monitor, Anda menghemat
biaya untuk daya dan memperpanjang masa
pakal monitor.

El Bagaimana prosedurnya?

Saat diaktifkan, SmartContrast akan menganalisis
konten yang ditampilkan secara real time

untuk menyesuaikan warna dan mengontrol
intensitas cahaya lampu latar. Fungsi ini akan
secara dinamis menyempurnakan kontras

untuk pengalaman hiburan yang luar biasa saat
menonton video atau menjalankan permainan.

3.3 Philips SmartControl Lite

Perangkat lunak SmartControl Lite baru dari
Phillips memungkinkan Anda mengontrol
monitor melalui antarmuka grafis layar

yang mudah digunakan. Penyesuaian rumit
sebelumnya kini tidak ada lagi karena panduan
perangkat lunak yang mudah digunakan ini
akan memandu Anda menyesuaikan resolusi
penyempurnaan, Kalibrasi warna, Pengaturan
jam/fase, Pengaturan titik putih RGB, dsb.

Dengan dilengkapi teknologi algoritme inti
terbaru untuk pemrosesan serta respons yang
cepat, perangkat lunak berbasis lkon animasi
yang menarik dan mendukung Windows /

ini siap menyempurnakan pengalaman Anda
menggunakan monitor Philips!

K} Penginstalan
lkuti petunjuk dan selesaikan penginstalan.

Anda dapat mengaktifkannya setelah
penginstalan selesai.

Jika ingin mengaktifkannya di lain waktu, Anda
dapat mengklik cara pintas di desktop atau
toolbar.

PHILIPS wwwphilips.comiwelcome

Monitor driver and software installation
Systenn requinements:
= PC running Windaws 7, Vista, XP, 2000, 94

» Go to wew,philips.com/welcome w download the latest version of manitor driver

Philips SmartControl
System support and requirements:
1. System suppart Windows 7, Vista, XP.

2 Language support English, German, Spanish, French, lealian, Russian, Portuguese, Simpified Chinese
3. Phisips Monitor Plug nd Pay support

»Gotw
software.

Wizard pengaktifan pertama kali

* Setelah penginstalan SmartControl Lite
selesal, Wizard pengaktifan pertama kali
akan terbuka secara otomatis.

*  Wizard ini akan memandu Anda
menyesuaikan performa monitor secara
bertahap.

*  Menu Plug-in juga dapat dibuka untuk
menjalankan wizard di lain waktu.

* Anda dapat menyesuaikan pilihan lainnya
tanpa menggunakan wizard melalui panel
Standard (Standar).

B SmartControl 2 - Philips 22581 (C530715000001) ()X
SmartControl Lite PHILIPS

Wizard

You'll need to calbrate your display to get the most
accurate color. We encourage you to use the simple
tuning process by selecting the Start Wizard button.
This process involves a

that wil let y
] tune your disply and sa
| 1. Choose the Start Wizard button.
2. Follow the steps outined in this process.
Q 3. Save your settings for future use.

Adjust Audio

\5 Auto Pivot
e

Color Tnput

B

Options Presets

o
\ Multi Monitors

Help

Start Wizard

11



3. Pengoptimalan Gamb

r

F3 Memulai dengan panel Standard (Standar):

Menu Adjust (Penyesuaian):

*  Menu Adjust (Penyesuaian) digunakan
untuk menyesuaikan Brightness (Kecerahan),
Contrast (Kontras), Focus (Fokus), Position
(Posisi), dan Resolution (Resolusi).

* Anda dapat mengikuti petunjuk dan

melakukan penyesuaian.

» Cancel (Batal) mengkonfirmasi pengguna
jika ingin membatalkan penginstalan.

" W SmartControl

SmartControl Lite

2 - Philips 22581 (€530715000001) (/%)

PHILIPS

Brightness

Improperly adjusted Brightness wil result in 2 loss of
detail in darker image areas. Adjust the Brightness for
the best possible picture quality.

4

Brightness

o®

1.

2.

U :
Adiust

Lower the Brightness to the minimum level
Raise the Brightness to the desired level.
Adjust the Brightness as needed to achieve
an equal separation of the stripes.

Contrast
Color AR
. = Focus Brightness 100
..l. = s
| Position
undo Reset

Opﬁoéws pF

g Resolution
Help

W smartcontrol

SmartControl Lite

2 - Philps 22581 (C530715000001) {¥}(X,

PHILIPS

Contrast

Adjust the Contrast (use the sider) to keep detais in
lighter image areas.

Brightness

Contrast

= :
=

Color

L

9

Pasition

Raise the Contrast until the numbers 1 and 2
are na longer visble.

Slowly lower the Contrast to make the
numbers 2 and 3 reappear. The number 1
should remain barely visible.

*, Contrast 50

Undo Reset

Options pF

g Resolution

12

B SmartControl

SmartControl Lite

Adjust

Options

Help

B SmartControl

SmartControl Lite

M

Adiust

a

Color

bﬁ,

Options

B SmartControl

SmartControl Lite

Adijust

‘Options

Help

2 - Philps 22581 (C530715000001) §%}(%)
PHILIPS

Focus

Your display's timing needs to be synchronized with
the video signal.

1. Choose Auto Setup.

2. If the vertical bands are still visble, you'l need

to adjust the Pitch.

Pitch: Try to make the vertical bands disappear.
Phase: Adjust to the brightest setting to minimize
movement on the scraen.

Brightness

o

Contrast
s Pitch 50

1
(+

Focus

1
+ 5

Position

F‘F

)
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PHILIPS

Undo Auto Setup

Position

Use the Position buttons to center the image on
your display. Using this tool, you can position the image
up, down, left, or right.

1. Use the Up/Down buttons to center the image

vertically.
2. Use the Left/Right buttons to center the image
horizontaly.
Brightness
Contrast
Ma
Focus
&\
Undo Reset

Resolution

2 - Philps 22581 (C530715000001) (%)X )
PHILIPS

Resolution

You are currently at 2 Preferred resolution. For your
display to show crisp, clear text, colors, and images,
your display should be set to its Preferred resalution.

I your display is at 2 Non-Preferred resolution, click
on the Preferred button to change your resolution to
Preferred.

- ™ Enable Resolution Motifier
Brightness Picture Format
7 4:3 aspect ratio

erred

o p.

Resolution




3. Pengoptimalan Gambar
Menu Color (Warna):

" 8 SmartControl

" W SmartControl

SmartControl Lite

\ b . \
@I g‘i ) Ei
2.0
(
g

SmartControl Lite

Menu Color (Warna) digunakan untuk
menyesuaikan RGB, Black Level (Tingkat
Hitam), White Point (Titik Putih), Color
Calibration (Kalibrasi Warna), dan
Smartlmage Lite (Lihat bagian Smartimage
Lite).

Anda dapat mengikuti petunjuk dan
melakukan penyesuaian.

Untuk item submenu berdasarkan input
Anda, lihat tabel di bawah ini.

Misalnya Color Calibration (Kalibrasi
Warna).

PHILIPS

Black Level
Improperly adjusted Black Level wil result in a loss of

detai in darker image areas. Adjust the Black Level for
the bast possible picture quality.

1. Adjust the black level of the Red, Green, and
Blue using the slider bars.

RGB
bﬂ Red
Black Level

White Point - &

g Blua

Display Garmma o O

1
g Undo Reset

Options Calibration

+ a2

1
&g

ap

Smartlmage

%

Help

2 - Philips 22581 (C530715000001) {F} %)
PHILIPS

White Point

White Point is the point at which equal combinations
of red, green, and blue light at fullintenstty create
white. This effects the overal color quality. For the
most accurate colors click the Reset button then

r | select the White Point.
| 1. Please select the White Paint value for the best
. m possble color qualty.
Adjust RGB
—
Color Wh!e Point
- White Point 6500K
Display Gamma o o &
)
2 Undo Reset
Options calibration
L
ap
SmartImage

%

2 - Philips 225B1 {C530715000001) 35 |

13

B St Contiol

SmartControl Lite

Adjust RER
\‘ Disck Lavel
. e
White Pont
.
Display Gamma.
' -
Options Gibiatan
> ap
Srrarthrage
Hulp
" SmartControl

SmartControl Lite

RGE
Elhz!q Level

White Point

Display Garrera
Calbravion

ab

Smartimage

& § N\

2 - Philps 22581 (530715000001 ) I x

PHILIPS

Display Gamma

Garmma

1. Use the sider to select the desred Camma

Dsplay Gamma 22
= L +
= e Off
Unda Rasat

2 - Philps 22581 (C530715000001) (3] 5.
PHILIPS

Calibration

Your deply neads to be propery calibrated in order
for & to produce the widest range of colors accurately.
Calibration should abways take place as the bst tuning
step In the process. Remember to recalbrate any tme
you make individual adjustments to image quality or
whenever you move your display to 2 new lacation.
1. Mzke al other necessary adjustments to image
qualty first.
2. Press Show Me to leam how to use the
calibration took.
3. Fingly, press Start to begn the calibration
process.

¥ Enable color calbration

Color software designed in colaboration with Joseph
Halrrus.

Paatected by U.S. Patent No. 6,686,953

Show Me Start.

Quick View

"Show Me" (Tunjukkan) memulai tutorial

kalibrasi warna.

Start (Mulai) - memulai urutan kalibrasi

warna 6 langkah.

Quick View (Tampilan Ringkas) memuat
gambar sebelum/sesudah kalibrasi.

Untuk kembali ke panel awal Color
(Warna), klik tombol Cancel (Batal).
Enable color calibration (Aktifkan kalibrasi
warna) - telah diaktifkan secara default.
Jika tidak dicentang, kalibrasi warna tidak
dapat dijalankan serta tombol start (mulai)
dan quick view (tampilan ringkas) akan

dinonaktifkan.

Info paten harus ditampilkan di layar

kalibrasi.
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Layar Kalibrasi warna pertama:

* Tombol Previous (Sebelumnya)
dinonaktifkan hingga layar kalibrasi warna
kedua ditampilkan.

* Next (Berikutnya) menampilkan layar sesuai
urutan selanjutnya (6 target).

* layar terakhir menampilkan panel
File>Presets (File>Preset). !

* Cancel (Batal) menutup antarmuka .
pengguna dan kembali ke halaman plug in.

Smartlmage Lite

Memungkinkan pengguna mengubah pengaturan .
layar menjadi lebih baik berdasarkan konten.

Bila Entertainment (Hiburan) ditetapkan,
SmartContrast dan SmartResponse akan

8 smartcontrol (LI
SmartControl Lite PHILIPS
SmartImage
SmartImage provides different brightness and
contrast levels to accomodate today's wide range of
computer applications.
S Choose the setting that is most comfortable or
| efficient when viewing your application. Alternatively, o
b l! simply choose the one that bast describes its type.
Adiust RGE
. —=a
‘.\U Black Level
Color White Point
g
Display Gamma
- !
Options Calbration
Game
Help

Internet Standard

\

Options>Preferences (Pilihan>Preferensi) -
Hanya diaktifkan sewaktu memilih Preferences
(Preferensi) dari menu drop-down Options
(Pilihan). Di layar yang tidak didukung, namun

14

8 smartControl

dilengkapi DDC/CI, hanya tab Help (Bantuan)
dan Options (Pilihan) yang tersedia.

2 - Philps 22581 (CS30715000001) ()%, '

SmartControl Lite PHILIPS
Preferences
You can use the following options to configure
SmartControl.
¥ Enable menu when right-clicking on desktop
S g ¥ Enable task tray menu
| Preferences ¥ Run at system start-up
| Set Transparency:
€ 0% © 50% © 100%
St Audio Select language:
Englsh o
D Auto Prot
-
Color Tnput
Y
e + 1
! Wizard
A
2
Options Presets

Mutti Monitors

&

Help

Menampilkan pengaturan preferensi saat ini.

Jika kotak dicentang, fitur akan diaktifkan.
Kotak centang berfungsi sebagai pengunci.

Enable Context Menu (Aktifkan Menu
Konteks) di desktop dicentang (Aktif)
secara default. Enable Context Menu
(Aktifkan Menu Konteks) menampilkan
pilihan Select Preset (Pilih Preset) dan
Tune Display (Sempurnakan Layar) untuk
SmartControl Lite dalam menu konteks klik
kanan di desktop. Disabled (Dinonaktifkan)
menghapus SmartControl Lite dari menu
konteks klik kanan tersebut.

lkon Enable Task Tray (Aktifkan Baki Tugas)
dicentang (Aktif) secara default. Aktifkan
menu konteks menampilkan menu baki
tugas untuk SmartControl Lite. Mengklik
kanan ikon baki tugas akan menampilkan
pilihan menu Help (Bantuan), Technical
Support (Dukungan Teknis), Check for
Update (Periksa Pembaruan), About
(Tentang), dan Exit (Keluar). Bila Enable
task tray menu (Aktifkan menu baki tugas)
dinonaktifkan, ikon baki tugas hanya akan
menampilkan EXIT (KELUAR).

Run at Startup (Jalankan Saat Pengaktifan)
dicentang (Aktif) secara default. Bila
dinonaktifkan, SmartControl Lite tidak akan
berjalan saat pengaktifan atau tidak akan
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ditampilkan dalam baki tugas. Satu-satunya
cara menjalankan SmartControl Lite
adalah melalui cara pintas desktop atau file
program. Preset apapun yang ditetapkan
untuk berjalan saat pengaktifan tidak

akan dimuat bila kotak ini tidak dicentang
(Dinonaktifkan).

* Enable transparency mode (Aktifkan mode
transparansi) (Windows 7, Vista, XP). Nilai
default adalah 0% Tidak Tembus Cahaya.

Options>Input (Pilihan>Input) - Hanya
diaktifkan sewaktu memilih Input dari menu

drop-down Options (Pilihan). Di layar yang tidak

didukung, namun dilengkapi DDC/CI, hanya
tab Help (Bantuan) dan Options (Pilihan) yang
tersedia. Semua tab SmartControl Lite lainnya
tidak tersedia.

2 - Phiips 22581 (€S30715000001) {F}| X,

PHILIPS

1 8 smartControl
SmartControl Lite

Input

Your display has two inputs (connections on back of
this display) so you can hook up two different sources
at the same time. Use the Analog In and Digital In
buttons to select which source you'd ke to view. You
are currently viewing the analog in image.

IMPORTANT! If you switch inputs SmartControl may
lose the ability to control your monitor. In this case you
may have to use the Input Select button on the front
of your monttor to switch back to the original input
before SmartControl functionality can be restored.

Adiust Audio

u Auto Pivot
Color Input
i B
_ 2
Optians Presets

Multi Monitors

Help

Anzlog In Digital In

* Menampilkan panel petunjuk Source
(Sumber) dan pengaturan sumber input
saat ini.

* Dilayar input tunggal, panel ini tidak akan
ditampilkan.

Options>Audio (Pilihan>Audio) - Hanya
diaktifkan sewaktu memilih Audio dan menu
drop-down Options (Pilihan).

Di layar yang tidak didukung, namun dilengkapi
DDC/CI, hanya tab Help (Bantuan) dan Options

(Pilihan) yang tersedia.

15
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PHILIPS

B SmartControl

SmartControl Lite

Audio

Adjust the Volume of the integrated loudspeakers by
using the slider.

Turn off the integrated loudspeakers by checking the
Mute checkbox.

Adiust ‘Audio

\@ Auto Pvot
T
Color Input
N k
\Q e
2
Options Prasats

Multi Monitors

Volume
Help =

=5
=z

Undo

Help>User Manual (Bantuan>Panduan
Pengguna) - Hanya diaktifkan sewaktu memilih
User Manual (Panduan Pengguna) dari menu
drop-down Help (Bantuan). Di layar yang tidak
didukung, namun dilengkapi DDC/CI, hanya
tab Help (Bantuan) dan Options (Pilihan) yang
tersedia.

B SmartControl 2 - Philps 22581 (C530715000001) | 2)\ %)

SmartControl Lite PHILIPS

User Manual

If you need help setting up or operating SmartControl,
click the Tech. Support button. You'll have the
option to fil out an Assstance Form.

You can also choose to have information about your

software automaticaly attached to the assistance
form. You'll need to be onine to use this feature.

Adiust g
" User Manual

P>
®

Update

Color
a
Display ID
- System ID
Options
N X%

Version

User Manual Tech. Support

Help>Version (Bantuan>Versi) - Hanya
diaktifkan sewaktu memilih Version (Versi) dari
menu drop- down Help (Bantuan). Di layar
yang tidak didukung, namun dilengkapi DDC/CI,
hanya tab Help (Bantuan) dan Options (Pilihan)
yang tersedia.
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B smartControl 2 - philips 22581 (CS30715000001) {F1X

SmartControl Lite PHILIPS

Version
SrartContral
Version 0.00
1913-04

EVALUATION dtune-plp-R2009-12-17-

DDC/CI Communication: Yes - ATIZ API

i

Copyright © 1993-2009 Partrait Displays, Inc.

Adjust

c
B

2@ 8

i

=
o
a’

Color

e

=N

o
3
]
=]

=
— AN
\E System ID

Options

<ﬁ

o =

@ o -
g

=

Menu Sesuai Konteks

Context Sensitive Menu (Menu Sesuai
Konteks) diaktifkan secara default. Jika Enable
Context Menu (Aktifkan Menu Konteks) telah
dicentang dalam panel Options>Preferences
(Pilihan>Preferensi), menu tersebut akan
ditampilkan.

D SmartControl

Select Preset L4

Menu Konteks memiliki empat entri:

*  SmartControl Lite - Bila dipilih, About
Screen (Tentang Layar) akan ditampilkan.

» Select Preset (Pilih Preset) - Memberikan
urutan menu preset yang disimpan untuk
digunakan di lain waktu. Tanda centang
menunjukkan preset yang saat ini dipilih.
Preset Pabrik juga dapat dipilih dari menu
drop down.

* Tune Display (Sempurnakan Layar) -
Membuka panel kontrol SmartControl Lite.

*  Smartlmage Lite - Memeriksa pengaturan
saat ini, seperti Standard (Standar), Internet,
dan Game (Permainan).

Menu Baki Tugas Diaktifkan

Menu baki tugas dapat ditampilkan dengan
mengklik kanan ikon SmartControl Lite dari baki
tugas. Klik kiri akan mengaktifkan aplikasi.

16

Help

Technical Support
Check for Update
About

Exik

Baki tugas memiliki lima entri:

* Help (Bantuan) - Mengakses file User
Manual (Panduan Pengguna): Buka file User
Manual (Panduan Pengguna) menggunakan
jendela browser default.

» Technical Support (Dukungan Teknis) -
Menampilkan halaman dukungan teknis.

»  Check for Update (Periksa Pembaruan) -
Mengarahkan pengguna ke Arahan PDI dan
memeriksa versi pengguna terhadap versi
terbaru yang tersedia.

e About (Tentang) - Menampilkan informasi
rinci tentang referensi: versi produk,
informasi edisi, dan nama produk.

* Exit (Keluar) - Menutup SmartControl Lite.

Untuk kembali menjalankan SmartControl Lite,
pilih SmartControl Lite dari menu Program, lalu
klik dua kali ikon PC desktop, atau hidupkan
ulang sistem.

PHILIPS

e
SmartControl

SmartControl
Version 3.20
cune-standard-R2007-01-04-1151-23
Copyright 1983-2007 Portrait Displays, Inc.
Patents Pending

Menu Baki Tugas Dinonaktifkan

Bila Baki Tugas dinonaktifkan dalam folder
preferensi, maka hanya pilihan EXIT (KELUAR)
yang tersedia. Untuk menghapus SmartControl
Lite secara keseluruhan dari baki tugas,
nonaktifkan Run at Startup (Jalankan Saat
Pengaktifan) dalam Options>Preferences
(Pilihan>Preferensi).



4. PowerSensor™

(Hanya tersedia untuk model 227E3LPH)

PowerSensor adalah teknologi ramah lingkungan yang unik dari Philips yang memungkinkan pengguna
menghemat penggunaan daya hingga 80%. Sejalan dengan drive Sense and Simplicity Philip, teknologi
yang praktis ini dapat digunakan seketika tanpa pemasangan perangkat keras atau penginstalan perangkat
lunak, dan tanpa intevensi pengguna dalam mode default.

1 Bagaimana prosedurnya?

» PowerSensor berfungsi berdasarkan prinsip transmisi dan penerimaan sinyal “inframerah” yang tidak
berbahaya agar dapat mendeteksi keberadaan pengguna.

* Bila pengguna berada di depan monitor, maka monitor akan beroperasi secara normal pada
pengaturan yang telah ditentukan pengguna, misalnya kecerahan, kontras, warna, dll.

* Misalnya, bila monitor ditetapkan pada kecerahan 100%, lalu pengguna meninggalkan kursinya dan
tidak lagi berada di depan monitor; maka monitor akan secara otomatis mengurangi penggunaan
daya hingga menjadi 80%.

Pengguna ada di depan Pengguna tidak ada

Penggunaan daya sebagaimana ditunjukkan di atas hanya ditujukan sebagai acuan

2 Pengaturan

Pengaturan default

Pada pengaturan default, (Pengaturan 3), PowerSensor dirancang untuk mendeteksi keberadaan

pengguna yang berlokasi antara 90 hingga 110 cm (35,4 hingga 43.3 inci) dari layar dan dalam 5 derajat
di kit maupun kanan monitor.

Pengaturan kustom

* Jika Anda ingin berada pada posisi di luar perimeter yang tercantum di atas, pilih kekuatan sinyal
yang lebih tinggi untuk efisiensi deteksi yang optimal: Semakin tinggi pengaturan, maka akan semakin
kuat sinyal deteksi. Untuk efisiensi dan deteksi tepat yang maksimum pada PowerSensor, posisikan
diri Anda tepat di depan monitor.

* Jika Anda memilih untuk berada lebih dari 110 cm atau 43,3 inci dari monitor, gunakan sinyal
deteksi maksimum untuk jarak hingga 130 cm atau 51,2 inci. (Pengaturan 4)

* Karena pakaian berwarna gelap tertentu cenderung menyerap sinyal inframerah meskipun
pengguna berada 100 cm atau 40 inci dari layar, tingkatkan kekuatan sinyal bila mengenakan
pakaian hitam atau berwarna gelap lainnya.

* Anda dapat setiap saat kembali ke mode default (Pengaturan 3).
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4. PowerSensor

Tombol pintas Jarak sensor

Power e ‘ = +3

/v /A SENSOR/ <4 /0K [0}

_—

El Cara menyesuaikan pengaturan

Jika PowerSensor tidak beroperasi dengan benar di dalam maupun luar kisaran default, berikut
adalah cara menyetel deteksi:

* Tekan tombol pintas PowerSensor.

* Anda akan menemukan posisi default ‘3’ pada panel penyesuaian.

* Atur penyesuaian deteksi PowerSensor ke (Pengaturan 4), lalu tekan OK.

* Uji konfigurasi baru ini untuk mengetahui apakah PowerSensor mendeteksi posisi Anda saat itu
dengan baik.

& Catatan

Mode PowerSensor yang dipilih secara manual akan tetap dioperasikan, kecuali jika dan hingga
disesuaikan ulang atau mode default digunakan. Jika Anda menyadari bahwa sensitivitas PowerSensor
terlalu tinggi terhadap gerakan sekitar karena alasan tertentu, atur ke kekuatan sinyal yang lebih rendah.



5. Spesifikasi Teknis

Jenis panel LCD LCD TFT

Lampu latar LED

Ukuran panel 215" (54,6 cm)
Rasio aspek 16:9

Jarak Piksel 0,248 x 0,248 mm
Kecerahan 250 cd/m?
SmartContrast 20,000,000:1

Rasio kontras (biasa) 1000:1

Waktu respons (biasa) 5ms

Resolusi Optimum 1920x1080 @ 60Hz

Sudut pandang

170° (H)/160° (V) @C/R>10

Penyempurnaan Gambar

Smartimage Lite

Warna layar

16,7 M

Input sinyal

Kecepatan refresh vertikal 56Hz - 76Hz
Frekuensi Horizontal 30kHz - 83kHz
sRGB YA

DVI-D (digital), VGA (Analog)

HDMI (tersedia untuk model 22/7E3LH, 22/E3LPH)

Sinyal Input

Kenyamanan Pengguna

Sinkronisasi Terpisah, Sinkronisasi pada Nyala Hijau

227E3L: En/v
227E3LH:  &p/v
227E3LPH: Ep/vw

©/A /<
/A 10/«
©/A SENSOR/

/0K Q)
/0K Q)
/0K Q)

Bahasa OSD

Inggris, Prancis, Jerman, ltalia, Rusia, Spanyol, China Modern, Portugis,

Turki

Kenyamanan lainnya

Kunci Kensington

Kompatibilitas Plug & Play

Kemiringan

DDC/CI, sRGB, Windows 7/Vista/XP, Mac OSX, Linux

-5/+20

Mode Aktif

227E3L:
227E3LH:

21,8W (standar)
21,8W (standar), 2/W (maks.)

227E3LPH: 21,8W (standar), 24W (maks.)

Pemakaian Daya
(Metode pengujian

Tegangan Input AC
pada 100VAC +/-

Tegangan Input AC
pada 115VAC +/-

Tegangan Input AC
pada 230VAC +/-

EnergyStar 5.0) 5VAC, 50Hz +/- 3Hz | 5VAC, 60Hz +/- 3Hz | 5VAC, 50Hz +/- 3Hz
Pgngoperasmn Normal 184W 184W 185W

(biasa)

Tidur (Siaga) 0,5W 0,5W 0,5W

Tidak Aktif 0,5W 0,5W 0,5W
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Penghilangan Panas*

Tegangan Input AC Tegangan Input AC | Tegangan Input AC
pada 100VAC +/- pada 115VAC +/- pada 230VAC +/-
5VAC, 50Hz +/- 3Hz | 5VAC, 60Hz +/- 3Hz | 5VAC, 50Hz +/- 3Hz

Pengoperasian Normal 62,8 BTU/jam 62,8 BTU/jam 63,174 BTU/jam
Tidur (Siaga) 1,71 BTU/jam 1,71 BTU/jam 1,71 BTU/jam
Tidak Aktif 1,71 BTU/jam 1,71 BTU/jam 1,71 BTU/jam
Indikator LED Daya Mode Aktif: Putih, Siaga/Tidur: Putih (Berkedip)

Catu Daya Efek terbakar, 100-240VAC, 50-60Hz

Produk dengan dudukan
(PxLxT)

534,34 x 407,9 x 216 mm

Kisaran suhu (beroperasi)

Produk tanpa dudukan

(PxLxT) 534,34 x 335,89 x 41,1 mm
Produk dengan dudukan 4,01kg

Produk tanpa dudukan 347kg

Produk dengan kemasan 417kg

0°C hingga 40°C

Kisaran suhu (tidak
beroperasi)

-20°C hingga 60°C

Pengesahan Peraturan

Kelembaban relatif 20% hingga 80%
- l?eroperasi: + 12.000 kaki (3.658 m)
tidak beroperasi: + 40.000 kaki (12.192 m)
MTBF 30.000 jam
lnglungan
ROHS YA
EPEAT Silver (www.epeat.net)
Kemasan 100% dapat didaur ulang

Penandaan CE, FCC Kelas B, GOST, SEMKO, Bersertifikasi TCO,
UL/cUL, BSMI, 1ISO9241-307

Warna Hitam (Belakang), Biru (Depan)
Lapisan Luar Mengkilap
& Catatan

1. EPEAT Gold atau Silver hanya berlaku di lokasi tempat produk Philips terdaftar Untuk status
registrasi di negara Anda, kunjungi www. epeat.net.

N

Informasi ini dapat berubah tanpa pemberitahuan sebelumnya. Untuk men-download selebaran

versi terbaru, kunjungi www.philips.com/support.




5.1 Mode Resolusi & Preset

E} Resolusi Maksimum
1920 x 1080 pada 60 Hz (input analog)
1920 x 1080 pada 60 Hz (input digital)

E3 Resolusi yang Disarankan
1920 x 1080 pada 60 Hz (input digital)

(Formar| Resolusi_[Jeis [Frec v. (1) |
480i 720x 480 | SD |60

480p 720x 480 | SD |60

576i 720x576 | SD |50

576p 720x 576 | SD |50

720p | 1280x 720 | HD (50, 60

10801 | 1920 x 1080 | HD |50, 60

1080p | 1920 x 1080 | HD |24, 25, 30, 50, 60

& Catatan

Perlu diketahui bahwa layar Anda akan berfungsi
sempurna dengan resolusi asli 1920 X 1080
pada 60Hz. Untuk mendapatkan kualitas
tampilan sempurna, ikuti saran resolusi ini.
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6. Manajemen Daya

Jika PC dilengkapi perangkat lunak yang

terinstal atau kartu tampilan yang terpasang
sesuai dengan DPM VESA, monitor secara
otomatis dapat mengurangi pemakaian daya
saat tidak digunakan. Jika terdapat input dari
keyboard, mouse, atau perangkat input lainnya
yang terdeteksi, monitor akan 'bangun’ secara
otomatis. Tabel berikut menunjukkan pemakaian
daya dan pemberian sinyal dari fitur hemat daya
otomatis in:

Mode Vid Sinkronisasi [Sinkronisasi| Daya yang Warna
VESA | “'“°® | horizontal | vertikal | Digunakan LED
Aktif | AKTIF Ya Ya <218 W Putih
(biasa)
, TIDAK , : <05 W Putih
Tidur AKTIF Tidak Tidak (biasa) (berkedip)
Matikan | TPAK _ _ <05W | TIDAK
A AKTIF (biasa) AKTIF

Berikut adalah konfigurasi yang digunakan untuk
menghitung pemakaian daya pada monitor.

* Resolusi asli: 1920 x 1080

*  Kontras: 50%

*  Kecerahan: 250 nit

*  Suhu warna: 6.500k dengan pola putih
sepenuhnya

& Catatan
Informasi ini dapat berubah tanpa
pemberitahuan sebelumnya.
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7. Informasi Peraturan

Lead-free Product

Lead free display promotes
environmentally sound recovery

& and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated

and compliance with European community's
stringent RoHs directive mandating restrictions
on hazardous substances in electrical and
electronic equipment have been adhered to

in order to make Philips monitors safe to use
throughout its life cycle.

Congratulations!

This display is designed for both you and the
planet

The display you have just purchased
carries the TCO Certified label.

This ensures that your display is
designed, manufactured and tested according to
some of the strictest quality and environmental
requirements in the world. This makes for a
high performance product, designed with the
user in focus that also minimizes the impact on
the climate and our natural environment.

TCO Certified is a third party verified program,
where every product model is tested by an
accredited impartial test laboratory. TCO
Certified represents one of the toughest
certifications for displays worldwide.

Some of the Usability features of the TCO
Certified for displays:

*  Visual ergonomics for good image quality
is tested to ensure top performance and
reduce sight and strain problems. Important
parameters are luminance, contrast,
resolution, black level, gamma curve, colour
and luminance uniformity and colour
rendering.

*  Products are tested according to rigorous
safety standards at impartial laboratories.

 Electric and magnetic fields emissions as
low as normal household background
levels.

* Low acoustic noise emissions (when
applicable).

Some of the Environmental features of the
TCO Certified for displays:

* The brand owner demonstrates corporate
social responsibility and has a certified
environmental management system (EMAS
or ISO 14001).

* Very low energy consumption both in on-
and standby mode minimize climate impact.

* Restrictions on chlorinated and brominated
flame retardants, plasticizers, plastics and
heavy metals such as cadmium, mercury
and lead (RoHS compliance).

* Both product and product packaging is
prepared for recycling.

* The brand owner offers take-back options.

The requirements can be downloaded from our
web site. The requirements included in this label
have been developed by TCO Development

in co-operation with scientists, experts, users as
well as manufacturers all over the world. Since
the end of the 1980s TCO has been involved

in influencing the development of IT equipment
in a more user-friendly direction. Our labeling
system started with displays in 1992 and is

now requested by users and IT-manufacturers
all over the world. About 50% of all displays
worldwide are TCO certified.

For more information, please visit:
www.tcodevelopment.com

TCOF1058 TCO Document,Ver. 2.1

I[n Technology for you and the planet
CERTIFIED




EPEAT
(Www.epeat.net)

“The EPEAT (Electronic Product
@ Environmental Assessment Tool)

program evaluates computer

desktops, laptops, and monitors
based on 571 environmental criteria developed
through an extensive stakeholder consensus
process supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the
design of products, and provides an opportunity
for manufacturers to secure market recognition
for efforts to reduce the environmental impact
of its products.”

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT'S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
means that these products will consume less
energy throughout their life.
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CE Declaration of Conformity

This product is in conformity with the following
standards

»  EN60950-1:2006 (Safety requirement of
Information Technology Equipment).

« EN55022:2006 (Radio Disturbance
requirement of Information Technology
Equipment).

*  EN55024:1998+A1:2001+A2:2003

(Immunity requirement of Information
Technology Equipment).

* EN61000-3-2:2006 (Limits for Harmonic
Current Emission).

«  EN61000-3-3:1995+A1:2001+A2:2005
(Limitation of Voltage Fluctuation and
Flicker) following provisions of directives
applicable.

»  2006/95/EC (Low Voltage Directive).
« 2004/108/EC (EMC Directive).

» 2005/32/EC (EuP Directive, EC No.
1275/2008 mplementing Directive
for Standby and Off mode power
consumption) and is produced by a
manufacturing organization on 1SO9000
level.

The product also comply with the following
standards

*  150O9241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

*  GS EK1-2000:2009 (GS mark requirement).

*  prEN50279:1998 (Low Frequency Electric
and Magnetic fields for Visual Display).

*  MPR-II (MPR:1990:8/1990:10 Low
Frequency Electric and Magnetic fields).

+ TCO CERTIFIED (Requirement for
Environment Labeling of Ergonomics,
Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees)
for TCO versions.



Energy Star Declaration

(Www.energystar.gov)

As an ENERGY STAR® Partner, we
have determined that this product
meets the ENERGY STAR®
guidelines for energy efficiency.

ENERGY STAR

& Note

We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission (FCC)
Notice (U.S. Only)

& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.

This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turming the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

» Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

* Consult the dealer or an experienced
radio/TV technician for help.
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@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following
two conditions: (1) this device may not cause
harmful interference, and (2) this device must
accept any interference received, including
interference that may cause undesired
operation.

Commission Federale de la Communication
(FCC Declaration)

© Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numeériques de class B,aux termes de l'article
15 Des régles de la FCC. Ces limites sont
concues de facon a fourir une protection
raisonnable contre les interférences nuisibles
dans le cadre d'une installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences
nuisibles aux communications radio.



Cependant, rien ne peut garantir |'absence
d'interférences dans le cadre d'une
installation particuliere. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, I'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer 'antenne de
réception.

* Augmenter la distance entre I'équipement
et le récepteur.

*  Brancher I'équipement sur un autre circuit
que celui utilisé par le récepteur.

¢ Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiere de conformité est susceptible
d'interdire a I'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTE TOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.
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EN 55022 Compliance (Czech Republic Only)

Thiz devica belongs to catagory B devices as described in EM 55022, unless it is spsacifi-
cally stated that it is a Class A device on the specification labal. The following applies to
devices in Class A of EN 55022 (radius of protection up to 30 meters). The ussr of the
device is obliged to taks all staps necessary to remove sources of intarfarence o tels-
communication or athar devices.

Pokud nani na typowam &tithu poditade uvedeno, 8 spada do do fidy A podis EN 55022,
spadd automaticky do tfidy B podie EN 55022, Pro zafizeni zatazrend do thidy A (chranné
péamo 30m) pedie EN 55022 platl nésledujicd. Dojde-ll k rufenl telekormumikatnich nabo
Fnich zafizeni je ufivatel povinnen prowdst takovd opatfgnl, aby rulieni odstranil.

Polish Center for Testing and Certification
Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer, and so
on) should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/
T-42107 and PN-89/E-06251.

Wymagania Polskiego Centrum Badan i Certyfikacyi

Usradzeide powiano byd zasibane = galazds 2 preybacsnym obwodem ochronmym (gniasdo 2
kolkvenh, Wapdtpracugnce ze soby uresdeenia (komputer, monator, drokarkap powinny by msilome
# i sk rddla.

Instalacja elektrycoma pomieszceenta powine mwiesas w preewadsie Browym reeeraows achrong
proec] swarciami, w postaci bezprecenika o warkedcl mamionowe] me wigkszej nit 16A {amperew ).
W eelu catkowitego wylacrenia urzadeenta 2 siect zasilania, naledy wyjat wivezks kabla
sasllaigeego 2 gmazdka, kidre powlmnno ssjdowad s w pobliag ureadeenda 1 byd 2atwo dostgpie.

Znak berpicezefsiwa "B" potwiendea spodnost uresdrenia 2 wymaganiami beepiecefiuiwa
ukytkowanda yawartvitl w FR-UAT-H2107 1 PN-REAM2S].

Pozostale instrukcje bezpieczensiwa

* Mie maledy whwad wiyceek adaptenowvch lub wuwad kedka abwodi ochronnego = wiyceki.
Tedelt komsecene jest whycie preedbutacza e naledy whyd preediuiace 3-avlowego 2
prawidbowa polsceonymm preewodem ochmannym.

System kompulerowy naleky sabespieceyd preed naphyme, chwilowymi werostami lub spad-
kami napsgcia, wiywijae eliminatan preepies, urrasdzemia dopasawajacege leh
berraklaceniowegn Frodia easilania

Maleiy |||1vm|t sl albvy e o lekaloona kablsch systerni kull'qmll:uml.gfr arax aby kable me
byly umieszczone w |n||.| cu, gideie medna byloby na nie nadepiywad lub porylst sig o me.

* Mie maledy rozlewad napogia am meych plyaio s systeim kampubenowy.

Mie maleiy wpychal fadnveh preedmictio: do abwendw systenu kemputercwega, plyi moke
ta spowodowai pegar lub porasenie prydem, poprees swancie elemeniaw wewngirznych

- Syt kompulenowy powiiac enapdowad sl 2 dala od greejnikbo o deddel clepla. Porsdro,
re paledy blakawas atwerdw wentylacyjeych. Naledy unikac kladeensa luznpeh papseriw posd

kampriter sz amisseczania kampabera wociasnym migjsew bex mazliwass cyrkalacii powi-
elnm wokol nisgoe.



North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS,

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SIOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR

STOMTILF@RSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)
NELHENERIIEE
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Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schdden durch Rontgenstrahlen" festgelegten
Vorschriften.

Auf der Rickwand des Gerétes befindet sich
ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Storstrahlern nach Anlage
a5 Abs. 4 der Rontgenverordnung erfillt
sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, daf3

1. Reparaturen nur durch Fachpersonal
durchgeflhrt werden.
nur original-Ersatzteile verwendet werden.

3. bei Ersatz der Bildrohre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Griinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhohte Augenbelastung bei zu
geringem Zeichenkontrast waren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betragt 70dB (A) oder
weniger.

M ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUR LEICHT
ZUGANGLICH SIND.



7. Informasi Peraturan |
China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.
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8. Layanan pelanggan dan
jaminan

8.1 Kebijakan Cacat Piksel Monitor
Panel Datar Philips

Philips berupaya memberikan produk berkualitas
tertinggi. Kami menggunakan beberapa proses
produksi tercanggih di industri dan menerapkan
kontrol kualitas yang ketat. Namun, cacat piksel
atau subpiksel pada panel LCD TFT yang
digunakan di monitor panel datar terkadang
tidak dapat dihindari. Tidak ada produsen yang
dapat menjamin semua panel akan bebas dari
cacat piksel, namun Philips menjamin bahwa
setiap monitor dengan jumlah cacat yang tidak
dapat diterima akan diperbaiki atau diganti sesuali
dengan jaminan yang berlaku. Pemberitahuan

Ini menjelaskan berbagal jenis cacat piksel dan
menentukan tingkat cacat yang dapat diterima
untuk masing-masing jenis tersebut. Untuk
memenuhi syarat dalam mendapatkan perbaikan
atau penggantian sesuai jaminan, jumlah cacat
piksel pada panel LCD TFT harus melampaui
tingkat yang dapat diterima. Misalnya, jumlah
cacat subpiksel pada monitor tidak boleh

lebih dari 0,0004%. Philips bahkan selanjutnya
menentukan standar kualitas lebih tinggi untuk
jenis atau kombinasi cacat piksel tertentu yang
lebih nyata dibandingkan dengan yang lainnya.
Kebijakan ini berlaku secara global.

4 N

Subpiksel Subpiksel

v Y
G R G B
piksel
- /

Piksel dan Subpiksel

Piksel, atau elemen gambar; terdiri dari tiga
subpiksel dalam warna utama merah, hijau,
dan biru. Kombinasi beberapa piksel akan
membentuk gambar. Bila semua subpiksel pada
piksel menyala, kombinasi ketiga subpiksel
berwarna tersebut akan muncul sebagai satu
piksel putih. Bila semua mati, kombinasi ketiga

Subpiksel
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subpiksel berwarna akan muncul sebagai satu
piksel hitam. Kombinasi lainnya dari subpiksel
yang menyala dan mati akan muncul sebagai satu
piksel warna lain.

Jenis Cacat Piksel

Cacat piksel dan subpiksel muncul di layar dalam
berbagai bentuk. Ada dua kategori cacat piksel
dan masing-masing kategori tersebut terdiri dari
beberapa jenis cacat subpiksel.

Cacat Titik Terang

Cacat titik terang muncul sebagai piksel maupun
subpiksel yang selalu terang atau 'menyala’.
Karenanya, titik terang merupakan subpiksel yang
terlihat jelas di layar bila monitor menampilkan
pola gelap. Berikut adalah jenis cacat titik terang:

4 N

N J
Satu subpiksel merah, hijau, atau biru terang
s N

I C

- /
Dua subpiksel terang yang berdekatan:

- Merah + Biru = Ungu

- Merah + Hijau = Kuning

- Hijau + Biru = Cyan (Biru Muda)

4 N

o /

Tiga subpiksel terang yang berdekatan (satu
piksel putih)



€ Catatan

Titik terang merah atau biru harus lebih dari 50
persen lebih terang daripada titik di sekitarnya,
sedangkan titik terang hijau 30 persen lebih
terang daripada titik di sekitarnya.

Cacat Titik Gelap

Cacat titik gelap muncul sebagai piksel maupun
subpiksel yang selalu gelap atau 'mati'. Karenanya,
titik gelap merupakan subpiksel yang terlihat
jelas di layar bila monitor menampilkan pola
terang. Berikut adalah jenis cacat titik gelap:

4 N

4 I N

CACAT TITIK TERANG

Jarak Cacat Piksel

Karena cacat piksel dan subpiksel sejenis yang
saling berdekatan mungkin terlihat lebih nyata,
Philips juga menentukan toleransi untuk jarak

cacat piksel.

s N
a N
- /

\ J

Toleransi Cacat Piksel

Untuk memenuhi syarat dalam mendapatkan
perbaikan atau penggantian karena cacat piksel
selama masa berlaku jaminan, panel LCD TFT
pada monitor panel datar Philips harus memiliki
cacat piksel maupun subpiksel melebihi toleransi
yang tercantum dalam tabel berikut ini.

TINGKAT YANG DAPAT DITERIMA

1 subpiksel terang 3
2 subpiksel terang yang berdekatan 1
3 subpiksel terang yang berdekatan (satu piksel putih) 0
Jarak di antara dua cacat titik terang* >15mm
Total cacat titik terang dan semua jenis 3

CACAT TITIK GELAP
1 subpiksel gelap

TINGKAT YANG DAPAT DITERIMA
5 atau lebih sedikit

2 subpiksel gelap yang berdekatan

2 atau lebih sedikit

3 subpiksel gelap yang berdekatan

0

Jarak di antara dua cacat titik gelap™

>15mm

Total cacat titik gelap dari semua jenis

5 atau lebih sedikit

TOTAL CACAT TITIK

Total cacat titik terang atau titik gelap dan semua jenis

TINGKAT YANG DAPAT DITERIMA

5 atau lebih sedikit

& Catatan

1. 1 atau 2 cacat subpiksel yang berdekatan = 1 cacat titik
2. Monitor ini sesuai dengan ISO 9241-307. (1509241-307: Metode pengujian kesesuaian, analisis, dan
persyaratan ergonomis untuk tampilan visual elektronik)
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8.2 Layanan pelanggan dan jaminan

Untuk informasi rinci tentang cakupan jaminan dan persyaratan dukungan tambahan yang berlaku di
negara Anda, kunjungi situs Web www.philips.com/support. Anda juga dapat menghubungi nomor
Pusat Layanan Pelanggan Philips setempat yang tercantum di bawah ini.

Informasi kontak untuk kawasan EROPA BARAT:

Negara ASC Nomor layanan konsumen  Harga
Germany Siemens I&S +49 01803 386 853 €0,09
United Kingdom Invec Scotland +44 0207 949 0069 Local call taniff
Ireland Invec Scotland +353 01 601 1161 Local call tariff
Spain Eatsa Spain +34 902 888 /85 €010
Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 €0,09
Greece Allman Hellas +30 00800 3122 1223 Free of charge
Italy A-novo +39 840 320 041 €0,08
Netherlands E Care +31 0900 0400 063 €0,10
Denmark A-novo +45 3525 8761 Local call tariff
Norway A-novo +47 2270 8250 Local call taniff
Sweden A-novo +46 08 632 0016 Local call tariff
Poland Zolter +48 0223491505 Local call taniff
Austria Siemens &S +43 0810 000206 €007
Belgium E Care +32 078 250851 € 0,06
Luxembourg E Care +352 26 84 30 00 Local call taniff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call taniff
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Informasi kontak untuk kawasan EROPA TENGAH DAN TIMUR:

BELARUS NA IBA +37517 217 3386
BULGARIA NA LAN Service +359 2 960 2360
CROATIA NA Renoprom +3851 3330974
ESTONIA NA FUJITSU +372 6519900
LATVIA NA “ServiceNet LV" Ltd. +371 7460399
LITHUANIA NA UAB "Servicenet" +370 7400088
ROMANIA NA Blue Ridge Intl. +40 21 2101969
;Egﬁf‘l\'Egl(\lEGRO NA Kim Tec d.o.o. +381 11 20 70 684
SLOVENIA NA PC H.and +386 1 530 08 24
U AN NA Comel +380 562320045
NA Topaz-Service Company | +38 044 245 /3 31
S NA CPS +7 (495) 645 6746 (for repair)
NA CEEE Partners +7 (495) 645 3010 (for sales)
Slovakia NA Datalan Service +421 2 49207155
Turkey NA Techpro +90 212 444 4 832
Czech Rep. NA Asupport 800 100 697
Hungary NA Serware . +36 1 2426331
NA Profi Service +36 1 814 8080

Informasi kontak untuk kawasan AMERIKA LATIN:

Pusat informasi Nomor layanan konsumen
Brazil 0800-7254101

Vermont
Argentina 0800 3330 856

Informasi kontak untuk China:

China
Nomor layanan konsumen: 4008 800 008

Informasi kontak untuk AMERIKA UTARA:

Negara Pusat informasi ~ ASC Nomor layanan konsumen
USA. TOS Teleplan (877) 835-1838
Canada Supercom Supercom (800) 479-6696
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Informasi kontak untuk kawasan APMEA:

Pusat informasi Nomor layanan konsumen
Australia NA AGOS NETWORK PTY LTD | 1300 360 386
New Zealand | NA Visual Group Ltd. 0800 657447
Hong Kong / : Hong Kong:Tel: +852 2619 9639
Macau NA smart Pixels Technology Ltd. | \p. - Tel: (853)-0800-987
: Tel: 1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PHILIPS to 56677
Indonesia NA PT. Gadingsari elektronika Tel: 62 21 75909053, 75909056,
| Prima 7511530
South Korea NA PCS One Korea Ltd. 080-600-6600
: After Market Solutions (CE)
Malaysia NA Sdn Bhd 603 7953 3370
Pakistan NA Philips Consumer Service (9221) 2737411-16
Philips Electronics Singapore
Singapore NA Pte Ltd (Philips Consumer (65) 6882 3999
Care Center)
PCCW
Taiwan Teleservices FETEC.CO 0800-231-099
Taiwan
Thailand NA ﬁz's Computer System Co. | 01 934.5498
South Africa NA Sylvara Technologies Pty Ltd | 086 0000 888
UNITED ARAB AL SHAHD COMPUTER
EMIRATES NA LLC 00971 4 2276525
Israel NA Eastronics LTD 1-800-567000
: , +84 8 38248007 Ho Chi Minh City
Vietnam NA EZTmsear:'C‘Et!‘format'c +84 5113.562666 Danang City
pany e +84 5113.562666 Can tho Province
T : (02) 633-4533 to 34,
Philippines NA Glee Electronics, Inc. (02) 637-6559 10 60
Sri Lanka NA no d!strlbutor and/or service
provider currently
Bancladesh NA Distributor: Computer Source | 880-2-9141747, 9127592
& Ltd (warranty buy-out) 880-2-8128848 / 52
Nepal NA Distributor: Syakar Co. Ltd 977.1-4229395
(warranty buy-out)
Distributor: Neat Technology
Cambodia NA Pte Ltd (Singapore) (warranty | 855-023-999992
buy-out)
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9. Mengatasi masalah & Tanya
jawab

9.1 Mengatasi Masalah

Halaman ini menjelaskan tentang masalah yang
dapat diatasi pengguna. Jika masalah terus
berlanjut setelah Anda mencoba solusi berikut,
hubungi staf layanan pelanggan Philips.

Kl Masalah Umum
Tidak Ada Gambar (LED Daya mati)

* Pastikan kabel daya telah tersambung ke
stopkontak dan ke bagian belakang monitor.

* Pastikan terlebih dulu tombol daya di bagian
depan monitor telah berada dalam posisi
OFF (TIDAK AKTIF), lalu tekan ke posisi
ON (AKTIF).

Tidak Ada Gambar (LED Daya Putih)

» Pastikan komputer telah dihidupkan.

» Pastikan kabel sinyal telah tersambung
dengan benar ke komputer.

» Pastikan pin pada kabel monitor yang
tersambung tidak tertekuk. Jika ya, perbaiki
atau ganti kabel.

*  Fitur Hemat Daya mungkin diaktifkan

Layar menampilkan

Attention

Check cable connection

* Pastikan kabel monitor telah tersambung
dengan benar ke komputer. (Lihat juga
Panduan Ringkas).

* Periksa pin yang tertekuk pada kabel
monitor.

* Pastikan komputer telah dihidupkan.

Tombol AUTO (OTOMATIS) tidak berfungsi

* Fungsi otomatis hanya berlaku dalam mode
Analog VGA Jika hasilnya tidak memuaskan,
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Anda dapat melakukan penyesuaian manual
melalui menu OSD.

& Catatan

Fungsi Otomatis tidak berlaku dalam mode
Digital DVI karena fungsi tersebut tidak
diperlukan.

Tanda yang tampak seperti asap atau kilatan

api

* Jangan lakukan langkah-langkah apapun
untuk mengatasi masalah

* Lepaskan segera monitor dari catu daya
utama untuk keselamatan

* Hubungi segera staf layanan pelanggan
Philips.

Bl Masalah Gambar

Gambar tidak berada di tengah

*  Atur posisi gambar menggunakan fungsi
“Auto” (Otomatis) dalam Kontrol Utama
OSD.

* Atur posisi gambar menggunakan Phase/
Clock (Fase/Jam) dalam Setup (Konfigurasi)
di Kontrol Utama OSD. Hal ini hanya
berlaku dalam mode VGA.

Gambar bergetar di layar
Pastikan kabel sinyal telah tersambung dengan
benar dan kencang ke papan grafis atau PC.

Kelip vertikal muncul di layar
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»  Atur gambar menggunakan fungsi “Auto”
(Otomatis) dalam Kontrol Utama OSD.

* Hilangkan baris vertikal menggunakan
Phase/Clock (Fase/Jam) dalam Setup
(Konfigurasi) di Kontrol Utama OSD. Hal ini
hanya berlaku dalam mode VGA.

Kelip horizontal muncul di layar
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»  Atur gambar menggunakan fungsi “Auto”
(Otomatis) dalam Kontrol Utama OSD.

* Hilangkan baris vertikal menggunakan
Phase/Clock (Fase/Jam) dalam Setup
(Konfigurasi) di Kontrol Utama OSD. Hal ini
hanya berlaku dalam mode VGA.

Gambar terlihat buram, tidak jelas, atau terlalu

gelap

* Atur kontras dan kecerahan di OSD (On-
Screen Display).

"Jejak gambar", "efek terbakar", atau "bayangan"
tetap muncul setelah daya dimatikan.

* Tampilan gambar diam atau gambar statis
yang tidak berubah dalam waktu lama
dapat menimbulkan “efek terbakar”, disebut
juga “jejak gambar’ atau “bayangan”, di
layar. “Efek terbakar”, “jejak gambar”, atau
“bayangan’ adalah fenomena umum dalam
teknologi panel monitor. Dalam sebagian
besar kasus, “efek terbakar”, “jejak gambar”,
atau “bayangan” akan menghilang secara
bertahap dalam waktu tertentu setelah daya
dimatikan.

* Aktifkan selalu program screensaver
bergerak bila Anda meninggalkan monitor.

* Aktifkan selalu aplikasi refresh layar berkala
jika Monitor akan menampilkan konten
statis yang tidak berubah.

* Gejala “efek terbakar”, “jejak gambar”, atau
“bayangan” yang fatal tidak akan hilang
dan tidak dapat diperbaiki. Kerusakan yang
disebutkan di atas tidak tercakup dalam
Jaminan.

Gambar tampak berubah. Teks tidak jelas atau
buram.

* Atur resolusi layar PC ke mode sama
seperti resolusi asli layar yang disarankan
monitor.

Titik hijau, merah, biru, hitam, dan putih muncul
di layar

» Titik tersisa adalah karakter normal yang
muncul pada liquid crystal yang digunakan
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dalam teknologi saat ini. Untuk informasi
lebih rinci, lihat kebijakan piksel.

Lampu “daya hidup” terlalu terang dan
mengganggu
* Anda dapat mengatur lampu “daya hidup”

menggunakan Konfigurasi LED daya dalam
Kontrol utama OSD.

Untuk bantuan lebih lanjut, lihat daftar Pusat
Informasi Konsumen dan hubungi staf layanan
pelanggan Philips.



9.2 Tanya Jawab SmartControl Lite

P1.  Saya mengganti monitor PC dan
SmartControl Lite menjadi tidak dapat
digunakan.Apa yang harus saya lakukan?

Jawab: Hidupkan ulang PC dan lihat apakah
SmartControl Lite dapat berfungsi.
Jika tidak, hapus dan instal ulang
SmartControl Lite untuk memastikan
driver yang benar telah diinstal.

P2.  SmartControl Lite berfungsi dengan
baik sebelumnya, namun kini tidak lagi.
Apa yang dapat saya lakukan?

Jawab: Jika tindakan berikut dilakukan, driver

monitor mungkin perlu diinstal ulang.

* Mengganti adapter grafis video

* Memperbarui driver video

» Aktivitas pada OS, misalnya service pack atau
patch

* Jalankan Windows Update serta driver
monitor dan/atau video yang diperbarui

* Boot di Windows dijalankan dengan monitor
dalam kondisi mati atau tidak tersambung.

*  Untuk mengetahuinya, klik kanan My
Computer (Komputer Saya), lalu klik
Properties->Hardware-> Device Manager
(Properti->Perangkat Keras->Manajer
Perangkat).

* Jika "Plug and Play Monitor" (Monitor Plug
and Play) ditampilkan dalam Monitor, Anda
harus menginstal ulang. Hapus dan instal
ulang SmartControl Lite.

P3.  Setelah menginstal SmartControl Lite,
bila tab SmartControl Lite diklik, layar
tidak menampilkan apapun setelah
beberapa saat atau layar menampilkan
pesan kegagalan. Mengapa demikian?

Jawab: Adapter grafis mungkin tidak kompatibel
dengan SmartControl Lite. Jika adapter
grafis adalah salah satu merek yang
disebutkan di atas, coba download driver
adapter grafis terbaru dari situs Web
perusahaan yang terkait. Instal driver.
Hapus SmartControl Lite, lalu instal
ulang sekali lagi.
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P4.

Jawab:

P5.

Jawab:

Jika tetap tidak berfungsi, kami mohon
maaf bahwa adapter grafis tersebut tidak
didukung. Kunjungi situs VWeb Philips dan
lihat apakah driver SmartControl Lite
terbaru telah tersedia.

Bila saya mengklik Product Information
(Informasi Produk), hanya sebagian
informasi yang ditampilkan. Mengapa
demikian?

Driver adapter kartu grafis mungkin
bukan merupakan versi terbaru yang
sepenuhnya mendukung antarmuka
DDC/CI. Coba download driver adapter
grafis terbaru dari situs Web perusahaan
yang terkait. Instal driver. Hapus
SmartControl Lite, lalu instal ulang sekali

lagl.

Attention

Check cable connection

Saya lupa PIN untuk Fungsi Theft
Deterrence (Pencegahan Pencurian).
Apa yang dapat saya lakukan?

Pusat Layanan Philips berhak meminta
identifikasi dan otorisasi resmi untuk
menetapkan kepemilikan monitor.

Perlu diketahui bahwa fungsi pencegahan
antipencurian diberikan sebagai pilihan
yang bebas dan mudah. Mengelola homor
PIN adalah sepenuhnya tanggung jawab
pengguna, baik perorangan maupun
organisasi, yang membuatnya.

Jika lupa nomor PIN, pusat layanan
Philips dapat membuat ulang PIN untuk
Anda dengan membebankan sejumlah
biaya setelah verifikasi kepemilikan.

Perlu diketahui bahwa aktivitas ini tidak
tercakup dalam persyaratan jaminan
standar.



9.3 Tanya Jawab Umum

P1:

Jawab:

P2:

Jawab:

P3:

Jawab:

Sewaktu memasang monitor, apa

yang harus saya lakukan jika layar
menampilkan "Cannot display this video
mode" (Tidak dapat menampilkan mode
video ini)?

Resolusi yang disarankan untuk monitor
ini: 1920 x 1080 pada 60Hz.

Lepas semua kabel, lalu sambungkan PC ke
monitor yang digunakan sebelumnya.

Dalam Windows Start Menu (Menu

Mulai Windows), pilih Settings/Control
Panel(Pengaturan/Panel Kontrol) . Dalam
Control Panel Window (Jendela Panel
Kontrol), pilih ikon Display (Tampilan).

Dalam Display Control Panel (Panel Kontrol
Tampilan), pilih tab "Settings" (Pengaturan).
Dalam tab pengaturan, dalam kotak "desktop
area" (area desktop), gerakkan panel samping
ke piksel 1920 x 1080

Buka "Advanced Properties" (Properti
Lanjutan), atur Kecepatan Refresh ke 60Hz,
lalu klik OK.

Hidupkan ulang komputer, lalu ulangi langkah
2 dan 3 untuk memverifikasi bahwa PC telah
diatur ke 1920 x 1080 pada 60Hz.

Matikan komputer; lepas monitor lama, lalu
sambungkan monitor Philips.

Hidupkan monitor, lalu hidupkan PC.

Berapa kecepatan refresh yang
disarankan untuk Monitor?

Kecepatan refresh yang disarankan
untuk Monitor adalah 60Hz. Jika
terdapat gangguan di layar, Anda
dapat mengaturnya hingga /5Hz untuk
mengetahui apakah gangguan tersebut
dapat diatasi.

Apakah yang dimaksud dengan file .inf
dan .icm pada CD-ROM? Bagaimana
cara menginstal driver (.inf dan .icm)?

Ini adalah file driver untuk monitor.
Untuk menginstal driver, ikuti petunjuk
dalam panduan pengguna. Komputer
mungkin akan menanyakan driver
monitor (file .inf dan .icm) atau disk
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P4.

Jawab:

P5:

Jawab:

Pé:

Jawab:

P7:

Jawab:

P8:

Jawab:

driver saat Anda menginstal monitor
untuk pertama kalinya. lkuti petunjuk
tentang cara memasukkan CD-ROM
pendamping yang disertakan dalam
kemasan ini. Driver monitor (file .inf dan
.icm) akan diinstal secara otomatis.

Bagaimana cara mengatur resolusi?

Kombinasi driver grafis/kartu video dan
monitor akan menentukan resolusi yang
tersedia. Anda dapat memilih resolusi
yang diinginkan dalam Panel Kontrol
Windows® dengan "“Display properties”
(Properti tampilan).

Bagaimana jika saya salah melakukan
penyesuaian monitor melalui OSD?

Tekan tombol OK, lalu pilih "Reset" (Atur
Ulang) untuk menggunakan kembali
semua pengaturan pabrik awal.

Apakah layar LCD antigores?

Secara umum, sebaiknya permukaan
panel tidak mengalami guncangan yang
berlebihan dan terlindungi dari benda
tajam atau tumpul. Sewaktu menangani
monitor, pastikan tidak ada tekanan atau
kekuatan berlebihan yang diberikan pada
sisi permukaan panel. Tindakan ini dapat
mempengaruhi ketentuan jaminan.

Bagaimana seharusnya cara
membersihkan permukaan LCD?

Untuk pembersihan normal, gunakan kain
bersih dan lembut. Untuk pembersihan
secara menyeluruh, gunakan isopropil
alkohol. Jangan gunakan bahan pelarut
lainnya seperti etil alkohol, ethanol,
aseton, hexane, dll.

Apakah pengaturan warna pada
monitor dapat diubah?

Ya. Anda dapat mengubah pengaturan
warna melalui kontrol OSD sesual
prosedur berikut,

Tekan "OK" untuk menampilkan menu OSD
(On Screen Display)

Tekan "Down Arrow" (Panah Bawah) untuk
menggunakan pilihan "Color" (Warna), lalu



tekan "OK" untuk membuka pengaturan

warna. Berikut adalah tiga pengaturan yang

tersedia.

1. Color Temperature (Suhu Warna);
Dengan pengaturan dalam kisaran 6500K,
panel menampilkan "hangat" dengan
nada warna merah-putih, sedangkan
suhu 9300K menghasilkan "nada dingin,
biru-putih”.

2. sRGB; Ini adalah pengaturan standar
untuk memastikan pertukaran warmna
yang benar di antara berbagai perangkat
(misalnya kamera digital, monitor, printer,
pemindai, dll.)

3. User Define (Ditentukan Pengguna);
Pengguna dapat memilih pengaturan
warna sesuai keinginannya dengan
menyesuaikan warna merah, hijau, dan
biru.

& Catatan:
Penghitungan warna lampu yang dipancarkan

oleh benda tertentu sewaktu sedang dipanaskan.

Penghitungan ini diberikan dalam persyaratan
skala absolut, (derajat Kelvin). Suhu Kelvin lebih
rendah seperti 2004K berwarna merah; suhu
lebih tinggi seperti 9300K berwarna biru. Suhu
netral adalah putih pada 6504K.

P9:  Apakah Monitor dapat disambungkan
ke PC manapun, workstation, atau Mac?

Jawab: Ya. Semua Monitor Philips kompatibel
sepenuhnya dengan PC, Mac, dan
workstation standar. Anda mungkin
memerlukan adapter kabel untuk
menyambungkan monitor ke sistem Mac.
Untuk informasi lebih lanjut, hubungi staf
penjualan Philips.

P10: Apakah Monitor Philips memiliki fungsi

Plug-and-Play?

Jawab: Ya. Monitor merupakan perangkat
Plug-and-Play yang kompatibel dengan
Windows 7/Vista/ XP/NT, Mac OSX,
Linux
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P11:  Apa yang dimaksud dengan Gambar
Menempel, Efek Terbakar, Jejak Gambar,

atau Bayangan pada panel LCD?

Jawab: Tampilan gambar diam atau gambar
statis yang tidak berubah dalam
waktu lama dapat menimbulkan "efek
terbakar", disebut juga "jejak gambar"
atau "bayangan’, di layar. "Efek terbakar",
"iejak gambar", atau "bayangan" adalah
fenomena umum dalam teknologi panel
LCD. Dalam sebagian besar kasus, "efek
terbakar", "jejak gambar", atau "bayangan"
akan menghilang secara bertahap dalam
waktu tertentu setelah daya dimatikan.
Aktifkan selalu program screensaver
bergerak bila Anda meninggalkan
monitor.
Aktifkan selalu aplikasi refresh layar
berkala jika Monitor akan menampilkan
konten statis yang tidak berubah.

7 Peringatan
Gejala "efek terbakar”, "jejak gambar”, atau

"bayangan" yang fatal tidak akan hilang dan tidak
dapat diperbaiki. Kerusakan yang disebutkan di
atas tidak tercakup dalam jaminan.

P12: Mengapa Layar tidak menampilkan teks
yang jelas, namun menampilkan karakter

bergerigi?

Jawab: Monitor berfungsi paling baik pada
resolusi asli 1920 x 1080 @60Hz. Untuk
tampilan terbaik, gunakan resolusi ini.
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